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Appendix A contains both the list of reports from which the tables were taken for the ETL and information1

regarding how these can be ordered. In some cases, the tables may not be exactly as reported in the publication. 

1

OVERVIEW

The Vocational Education Electronic Table Library (ETL) provides users with
immediate access to a comprehensive set of more than 100 vocational education tables
that have been published by the U.S. Department of Education over the last several years.1

The purpose of the Vocational Education ETL is to give users a convenient way of
searching for tables based on specific topics and keywords and then to output the tables
either for additional analyses or for referencing. Briefly the steps of a search include:

• Searching by subject (e.g., “Overall Participation in Secondary Vocational
Education”).

• Searching by keyword (such as “race–ethnicity” or “special populations”).

• Selecting a table title from those found from your search criteria.

• Choosing the display of the table (i.e., selected rows/columns or the entire table).

• Outputting the table. There are several output options, such as printing the table,
creating a text file of the table for editing in a word processor, or creating a comma-
or tab-separated file for importing into a spreadsheet program (such as Lotus 1-2-3
or Excel).

In addition to searching for and displaying the tables, there are also analytic
functions included in ETL. For example, when a table is displayed on the screen, users can
bring up the standard errors and sample sizes for each number (provided they are
available) using one keystroke that toggles the standard errors and sample sizes on and
off. Another key feature of ETL is the capability of performing significance tests
(Student’s t-test) on any two mean estimates in a table, provided the standard errors are
available. In order to conduct a t-test, the user highlights the numbers for testing, and the
t-value is computed. 

In the following sections, you will be guided step by step in how to use the many
features of the Vocational Education Electronic Table Library. We think you will find
ETL a convenient, easy to use, and powerful tool to assist you in searching for and using
the many tables of survey data that have been published by the Department of Education.



 This would be indicated by a line similar to the following in your CONFIG.SYS file:2

“device=c:\dos\emm386.exe noems.” In order to run ETL, you can either (1) not use emm386, or (2) use
emm386 and specify some amount of expanded memory (as low as 64K) rather than “noems.” For example,
you could specify: “device=c:\dos\emm386.exe 64” etc.
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INSTALLING THE SYSTEM

You can install ETL either directly from DOS or from the DOS shell in Windows 95. If
you have an earlier version of Windows, however, you should exit completely from the
Windows environment and install the program directly from DOS, since the installation
process may disrupt some Windows applications. Users should have about 400K of
conventional memory available to install and run the application reliably. Additionally,
ETL will not run if you are using expanded memory manager 386 (emm386) and you have
turned off your expanded memory.2

After satisfying the above requirements, you can install the program by inserting the
system diskette into the A: drive and entering:

>   a: 
> instal96

This will copy the application onto your hard drive and set up the system. The installation
program creates a subdirectory called VL96 on your C: disk drive into which the system
files are copied. If you do not want the system on your C: drive, the installation program
allows you to enter the drive and subdirectory where you want it installed. You need
install the system only once. To use the application after it is installed, just go to the
subdirectory C:\VL96 and follow the instructions for “Starting the Program” on the next
page.

GLOBAL COMMANDS

There are several function and control keys that can be invoked at any time during the
running of the program. These are as follows:

F1 Help.

F10 Proceed to next operation.

UP / DOWN Arrows Move up or down one line.

PgUp or PgDn Move up or down a page during scrolling.

ENTER (or RETURN) Select/unselect an item such as a table entry.

ESC Backs up to previous screen and aborts current one.
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STARTING THE PROGRAM

To start the program enter “VL” followed by the ENTER key as follows:

C:\VL96 >   VL  

 BEGINNING OPTIONS

The first screen that will appear after the introductory screen is shown in the following
figure (Screen 1). You have three options at this point: 

F1 Help.

ESC The ESC key exits the program to DOS.

RETURN Starts the table search procedure.

Screen 1
Beginning The Program

  
 NCES ELECTRONIC TABLE LIBRARY    

Friday  June 14, 1996  1:30 pm                                                                              
                                                                              
                                                                              
                                                                              
                                                                              
         Search, Retrieve, Display Tables

Press F1 at any time for help
Press Esc at any time to back up a step
Press Retn to select/retrieve/display a table             

                                                                                       

Esc=Exit to DOS      F1=Help 
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SUBJECT INDEX SELECTION

The subject index selection is much like a table of contents and refers to the report or
study in which the tables are published. In the case of large reports such as Vocational
Education in the United States: The Early 1990s, subsections may be chosen. For
example, in Screen 2 below, there are three subsections, all of which are from this report.
In addition to the abbreviated subject title, an abstract describing the chosen subject and
the NCES publication from which the tables are taken appears in a window at the bottom
of the screen. You have two search options at this point:

1) Search ONE or more subjects by HIGHLIGHTING each entry (highlighting turns
the entry gray) and pressing RETURN. You may unselect an entry in the same
way. You may also do a TEXT STRING SEARCH on the project title and
abstract. To do so, press the forward slash key (/) for searching down the list or
the backslash (\) for searching up the list. Just enter a slash key followed by the
text you wish to search for and the first subject line containing the text will be
highlighted. To search for the next occurrence press the slash key again (the
characters you typed reappear on the screen) and then press ENTER. Repeat the
text string search to find a new subject. 

2) Select ALL subjects by pressing the F3 function key. Use this option if you want
your table searches to apply to all tables, rather than a selected subset.

Screen 2
Subject Index Selection

NCES ELECTRONIC TABLE LIBRARY: Retrieve Existing Table

   Subject Index Selection          
   
  ID   Subject Index Description 

  001   Rp1:Ch1  NELS Overall Participation in Secondary Vocational Education:
 002   Rp1:Ch2  NELS Cooperative Education and Work Experience:
  003   Rp1:Ch3  NELS Levels of Vocational Coursetaking:

                        

 Percentage of 1992 public high school graduates completing courses in 
 various types of vocational education; average number of Carnegie units 
 earned by 1992 public high school graduates in various types of 
 vocational education. [NCES 95-024 Vocational Education in the United 
 States: The Early 1990s.]

                                                              

Esc, F10=Proceed, Retn=sel/unsel, F3=All      / , \ Text Search

Press F10 to PROCEED
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KEYWORD SEARCH

The next step allows you to search the tables selected in the subject index for specific
keywords. If you wish to bypass the keyword search so that you can select from all the
tables rather than a selected subset, press F10 without selecting any keywords. If you do
not find a particular keyword, it is possible to search table titles for the word in which you
are interested. To do so, bypass the keyword search function (F10) and do a text string
search on the table titles (described under “Selecting a Table” on the next page). As
described below, keyword searches can be performed on either an inclusive “or” or an
exclusive “and” basis.

To do a keyword search:
Select one or more keywords by HIGHLIGHTING each word and pressing ENTER. You
can unselect keywords by highlighting a selected word and again pressing the ENTER
key. Press F4 to get a list of all your chosen keywords. Press F4 again to go back to the
entire keyword list.

Type of Search (“AND” / “OR”)
When searching on more than one keyword select inclusive “OR” searches or exclusive
“AND” searches by pressing the F5 key. This key will toggle back and forth between
“OR” and “AND” searches.

Quick Find of Keywords
To find a specific keyword, you can either scroll through the list by using the arrow or
PgUp/PgDn keys, or you can type in any string of characters and the program will go
immediately to the first word that contains those characters. 

Screen 3
Keyword Selection

NCES ELECTRONIC TABLE LIBRARY: Retrieve Existing Table

Keyword Selection

KEYWORDS "OR" Search

Absentee Rates (high school)
Academic Achievement (see Achievement Tests)
Academic Coursework (high school)
Academic Disadvantage (high school)
Academic Disadvantage (postsecondary)
Academic Major (postsecondary)
Academic Program (postsecondary)
Academic Standards (high school)

Esc, F10=Proceed, Retn=sel/unsel, F4=Toggle All/Selctd, F5=Toggle AND/OR Mode 

Press F10 to PROCEED
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SELECTING A TABLE

The next display will be a list of table titles found for your subject index and/or keyword
selection(s). Each line displays the first line of the table title. The window at the bottom of
the screen displays the entire table title for the highlighted table. 

To select a table (you may only select one table at a time):

HIGHLIGHT a table title and press ENTER.

You may also do a TEXT STRING SEARCH on the table titles by using the forward
slash (/) for searching down the list or the backslash (\) for searching up the list. Just enter
a slash followed by the text you wish to search for and press the ENTER key. The
maximum number of text characters allowed is 29, after which the search will start
automatically (without pressing ENTER). The first table title containing the text will be
highlighted. To search for the next occurrence, press the slash key again (the characters
you typed reappear on the screen) and then press ENTER.

Screen 4
Selecting a Table

NCES ELECTRONIC TABLE LIBRARY: Retrieve Existing Table

Table Selection              
                                                                              
                                                                              

      TITLE                                                              

    Table 1–Percentage of 1992 public high school graduates completing on
    Table 2–Percentage of 1992 public high school graduates completing on
    Table 3–Percentage of 1992 public high school graduates completing on
    Table 4–Average number of Carnegie units accumulated by 1992 public h
    Table 5–Average number of Carnegie units accumulated by 1992 public h
    Table 6–Average number of Carnegie units accumulated by 1992 public h
    Table 7–Average number of Carnegie units accumulated by 1992 public h
    Table 8–Average number of Carnegie units accumulated by 1992 public h
    Table 9–Average number of Carnegie units accumulated by 1992 public h
    Table 10–Percentage of 1992 public high school graduates by number of
        
                                                                      
                                                                               Table 1–Percentage of 1992 public high school graduates completing 

 one or more courses in vocational education by type of vocational 
 education, by selected student characteristics             

Esc, F10=Proceed, Retn=sel/unsel      / , \= Text Search

Press F10 to PROCEED
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CHOOSING TABLE DISPLAY

After selecting a table, a list of the column labels will appear on the screen. At this point
you have two options for displaying the table:

1) Display the ENTIRE table by entering the letter W for whole table.

2) Choose a SUBSET of the table by selecting specific columns and rows. For example,
you may only be interested in industrial arts or consumer and homemaking education for
sex and race–ethnicity. To select a subset of the table: 

C HIGHLIGHT each desired column label by pressing RETURN 
C Press R for row selection
C HIGHLIGHT each desired row label by pressing RETURN
C Press F10 to display selections

Screen 5 below shows the initial display of column labels after table selection. The small
window to the right of the column labels displays the highlighted label exactly as it appears
on the table.

Screen 5
Choosing Table Display 

NCES Table 1–Percentage of 1992 public high school graduates

completing one or more courses in vocational…

 COLUMN     LABEL *
     1  Any vocational education * Any vocational
     2  Total\1 * education 
     3  Industrial arts *
     4  Career education *
     5  Consumer & homemaking education *
                                                                   

Esc, F10=Proceed, Retn=sel/unsel, F3=All  (W)hole table  (R)ows   /, \ =Text search

Press F10 to PROCEED
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NAVIGATING THE TABLE DISPLAY

Once the table appears on the screen, the following key commands allow easy access to
the different parts of the table.

C The right ARROW key will display additional COLUMNS that do not fit on the
initial screen display (move back by using the left ARROW key).

C Up and down ARROW keys and PgUp/PgDn keys will move up and down the
ROWS of the table.

C F1 Help.

C F3 Displays the entire TABLE TITLE.

C F4 Displays the table FOOTNOTES. 

C F10 Proceeds to TABLE OUTPUT OPTIONS.

C T Toggles the standard errors (SEs) and sample sizes on and off for the
particular row highlighted. Provided they have been published, this display
includes the standard error, unweighted N, and the weighted N. The weighted
N is displayed in thousands. 

C ESC Moves you back to the table selection list (Screen 4). If you are reading the
help screen, table title, or footnotes, the escape key moves you back to the
table.



t '(x1&x2)/ (SEx1)
2% (SEx2)

2,
Student’s t-statistic for independent samples (which is the method used in this software package) is defined3

as where x  and x  are the estimates being compared and SE refers to their1 2

corresponding standard errors. When testing for differences based on dependent samples, the covariance
between the estimates being tested needs to be taken into account when calculating the denominator of the t-
statistic.
For tables showing the t-statistic required to insure that p<=.05/k for a particular family size and degrees of4

freedom, see Oliver Jean Dunn, “Multiple Comparisons Among Means,” Journal of the American Statistical
Association, 56:52-64. 
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CONDUCTING T-TESTS ON TABLE ESTIMATES

While a table is displayed on the screen, you can test for statistically significant differences
between mean estimates by conducting a Student’s t-test on any two numbers. The user
should be aware that the Student’s t-test used in this application is based on the
assumption that the two estimates being compared come from two independent samples.3

For example, it would not be appropriate to compare a “total” estimate to a subgroup of
that total using a t-test designed for independent samples. For instance, in Report 1, table
114, it would not be appropriate to perform a t-test comparing the proportion of all
vocational education teachers with the proportion of vocational education teachers in
comprehensive high schools. It is also not appropriate to use this type of t-test to compare
estimates that are dependent proportions. For example, in Report 1, table 114, it would be
inappropriate to use this particular test to compare the proportion of vocational teachers
in comprehensive high schools who are under 30 years of age with those who are 50 years
or over. The two proportions are part of a percent distribution that sums to 100 percent
and are, therefore, correlated. An appropriate use of the t-test would be comparing the
proportion of vocational teachers who are 50 years or older with the proportion of
nonvocational teachers who are 50 years or older. 

Users should also be advised of the hazard in reporting statistical tests for paired
comparisons when making multiple paired comparisons among several categories of one
independent variable. For example, when making multiple paired comparisons among the
different race–ethnicities in table 1 of Report 1 (white vs. black; black vs. Hispanic; white
vs. Hispanic, etc.) the probability of a Type I error (rejecting a true null hypothesis) for
these comparisons taken as a group is larger than the probability for a single comparison.
Therefore, when testing for more than one difference among groups of related
characteristics or “families,” you must apply a standard that assures a level of significance
for all those comparisons taken together. One method for assuring such significance is to
apply the criteria p#.05/k, where k is the number of possible comparisons within a given
family. The value of k can be calculated as k=(j*(j–1) )/2 where j=number of categories
for an independent variable. For example, in comparing the proportion of students in each
racial–ethnic group in table 1, the number of race–ethnicities is 5, so k=(5*(5–1) ) /2 or
10. Thus, for 10 possible comparisons, p#.05/10 or .005, which corresponds to a t-value
of 2.81 for a two-tailed test.4



When doing a t-test the first number selected will remain anchored to allow you to test for differences with5

other estimates. For example, in table 1 of Report 1 you may wish to test whether or not Hispanic students are
more or less likely to participate in specific labor market preparation against all other ethnic groups. To do so,
first choose the estimate for Hispanics and then each other ethnic group in sequence. 

10

To calculate a t-value comparing two estimates:

1) Make sure the first number you are interested in appears on the screen. Use the
right and left ARROW keys to display additional columns. Highlight the line on
which the first number appears and press F5.

2) Use the right and left ARROW keys to select a specific number on the highlighted
line and press ENTER. A red highlight will then be anchored to the selected
number. If you make a mistake, you can clear your selection by pressing F6 and
then start over with step 1.

3) Follow steps 1 and 2 to select a second number. A window displaying the t-value
will then appear on the table. Press any key to clear the second number. Follow
steps 1 and 2 to select a new second number.5

4) To CLEAR the entire t-test function and start over by selecting a new first
number, press F6.

Press F10 to PROCEED
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TABLE OUTPUT OPTIONS

After proceeding from the table display (by pressing F10), several output options for the
table will appear in a window in the middle of the table (Screen 6). From these options,
you may choose one or more types of output for the table. If you do NOT wish to output
the table, press ESC to return to the table selection list (Screen 4).

A caution will appear at the bottom of the OUTPUT OPTIONS window, if the table
width is greater than 78 characters wide. In order to print a table wider than the standard
printer width, set your printer to compressed mode. 

To select one or more output options (each option is described on the next page),
HIGHLIGHT the desired option(s) and press ENTER. Use the arrow keys to move up
and down the option list. 

Screen 6
Choosing Table Output(s) 

NCES Table 1--Percentage of 1992 public high school graduates

completing one or more courses in vocational...

                                                                             

OUTPUT OPTIONS

                                                                              
Output Table to Printer/File (fixed-width file)
Create a Comma-Separated File (delimited file)
Create a Tab-Separated File (delimited file)

Creates an ASCII file that can be printed directly or 
opened in a word processor for editing.
 

                                                                              

Esc, F10=Proceed, Retn=sel/unsel

Press F10 to PROCEED
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OUTPUT OPTIONS

Option 1: Output Table to Printer / File

This option creates an ASCII (.PRN) file of the table, which can be printed directly or
opened in a word processor for editing. 

After HIGHLIGHTING this option and pressing ENTER, press F10 to go to the
OUTPUT TABLE IMAGE screen. This screen gives you three options: (1) Print Table;
(2) Write Table to File; and (3) Both. Select the desired option by HIGHLIGHTING your
choice and pressing ENTER. 

Pressing ENTER will display the table specifications window (see below). 

If you experience difficulty printing using the print command on the vocational education
electronic table library, create a comma- or tab-separated file and then print the file using
either a spreadsheet or word processing package.

Option 2: Create a Comma-Separated File 

Creates a comma-separated (.CSV) file that can be imported into a spreadsheet program
(such as Lotus 1-2-3 or Excel). 

After HIGHLIGHTING this option and pressing ENTER, press F10 to go to the table
specifications window (see below). 

Option 3: Create a Tab-Separated File 

Creates a tab-separated (.TXT) file that can be imported into a spreadsheet program (such
as Lotus 1-2-3 or Excel).

After HIGHLIGHTING this option and pressing ENTER, press F10 to go to the table
specifications window (see below). 

Selecting Table Specifications

After proceeding from the OUTPUT OPTIONS window by pressing F10 (or the
OUTPUT TABLE IMAGE window by pressing ENTER, in the case of Option 1), you are
presented with a choice of what to include in your table:

Means/Percentages Only
Only the mean estimates or percentages will appear in the table (not standard errors or
sample sizes).

All Data, Statistics Separate
This option creates the output file in separate sections: first, all the means or percentages
are output, followed by the standard errors, then the unweighted Ns.

Statistics Merged with Data
This option creates an output file with each cell containing the mean estimate, standard
error, weighted N, and unweighted N.



 If you did not set up your printer before running VL, pressing ENTER will cause you to exit from the5

program.
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To select a table specification, HIGHLIGHT the desired option and press ENTER. Use
the arrow keys to move up and down the option list. 

If you selected Output Option 1 and then the “Print Table” Output Table Image option,
pressing ENTER will send your table directly to the printer.6

If you selected Output Option 1 and then the “Both” Output Table Image option, pressing
ENTER will first ask you to name the file (see below), then write the file to the ETL
subdirectory, and finally send your table to the printer.5

If you selected Output Option 1 and then the “Write Table to File” Output Table Image
option, or you selected Output Option 2 or 3, pressing ENTER will ask you to name the
file by displaying the following prompt:

ENTER FILE NAME (default extension = )

The default extension (.PRN, .CSV, or .TXT) will depend on whether you selected
Output Option 1, 2, or 3 in Screen 6. Type in any name up to 8 characters in length and
press ENTER. The file will be written to the DOS subdirectory where ETL resides (the
default directory is C:\VL96). For example, if you choose to create a comma-separated
import file and name it “table_1”, the file will be saved as “table_1.csv” in the C:\VL96
drive. If you want to save the file on another disk drive and/or subdirectory, you can enter
the path along with the file name. For example, if you want to save the file on the D: drive
in a subdirectory called “work,” enter the following when asked for the file name:

D:\work\table_1.csv

and your file will be saved in D:\work. If you chose to output more than one type of file in
the OUTPUT OPTIONS window, the program will ask you to name each file in sequence. 

ASCII (.PRN) files can be opened in a wordprocessing program and edited. Comma- and
tab-separated files (.CSV and .TXT files) can be imported into a spreadsheet program. See
the IMPORTING TABLE FILES section on the next page for instructions on how to
import files into either Lotus 1-2-3 or Excel.
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NEXT OPERATION

After sending your table to a printer or writing it to a file, the NEXT OPERATION
window will appear, giving you three options for continuing:

1) Retrieve New Table with Same Subject/Keywords.

2) Start Over with New Subject Index.

3) Exit to Main Menu.

IMPORTING TABLE FILES

Comma- and tab-separated files (.CSV and .TXT files) can be imported into a spreadsheet
program that is capable of reading text files, such as Lotus 1-2-3 or Excel. Doing so
involves opening the file from within the spreadsheet program. In Lotus 1-2-3, you should
use the FILE–IMPORT–NUMBERS command (Windows users should bring up the menu
by hitting the “/” key, not by clicking on “File”); in Excel, you should use the FILE–OPEN
command. In Excel, you should also be sure to specify the appropriate COLUMN
DELIMITER for the text file (indicating whether it is a comma- or tab-separated file). If
you are prompted to enter a file name, be sure to give the correct drive and path for the
file. For instance, in the previous example you would enter the following

C:\VL96\table_1.csv

Once the file has been imported into a spreadsheet, the column widths may need to be
adjusted for readability. 

See Appendix B for illustrations of how to import files into Lotus 1-2-3 version 3.1, Excel
for Windows version 4.0, and Excel for Windows 95 version 7.0.
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APPENDIX A

Sources for ETL Tables

Available from the Government Printing Office (GPO)  (1-202-512-1800):

Report 1
Vocational Education in the United States: The Early 1990s, November 1995.

This publication synthesizes data on vocational students, teachers, and schools at both the
secondary and postsecondary level.

GPO order number: 065-000-00820-3. Cost: $21.00

Rp1:Ch1 Tables 1 to 21 Overall Participation in Secondary Vocational 
Education

Rp1:Ch2 Tables 22 to 24 Cooperative Education and Work Experience
Rp1:Ch3 Tables 25 to 33 Levels of Vocational Coursetaking
Rp1:Ch4 Tables 34 to 39 Curriculum Concentration and Specialization
Rp1:Ch5 Tables 40 to 49 Relationship Between Academic and Vocational 

Coursetaking
Rp1:Ch6 Tables 50 to 57 Participation in Secondary Vocational Education: 

1982–1992
Rp1:Ch7 Tables 58 to 70 Overall Participation in Postsecondary Vocational 

Education
Rp1:Ch8 Tables 71 to 88 Postsecondary Participation by Institutional Type
Rp1:Ch9 Tables 89 to 93 Student Profiles by Program and Institutional Type
Rp1:Ch10 Tables 94 to 95 Financial Aid
Rp1:Ch11 Table 96 Incarcerated Adults and Youths
Rp1:Ch12 Tables 97 to 99 Reforms in Secondary Schools
Rp1:Ch13 Tables 100 to 104 Reforms in Postsecondary Institutions
Rp1:Ch14 Tables 105 to 108 Vocational Coursetaking and Math Achievement
Rp1:Ch15 Tables 109 to 113 Postsecondary Employment and Earnings Outcomes
Rp1:Ch16 Tables 114 to 118 Teacher Characteristics
Rp1:Ch17 Tables 119 to 120 Teacher Training
Rp1:Ch18 Tables 121 to 123 Salaries, Class Size, and Teaching Load
Rp1:Ch19 Tables 124 to 127 Teacher Trends: 1987–1990

Report 2
Public Secondary School Teacher Survey on Vocational Education, January 1994.

This publication compares academic and vocational teachers, classes, and courses in public
secondary schools in 1992. 

GPO order number: 065-000-00630-8 Cost: $5.50

Rp2:Ch1  Tables 1 to 25 Public Secondary School Teacher Survey
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Report 3
Vocational Course Taking and Achievement: An Analysis of High School Transcripts and
1990 NAEP Assessment Scores, May 1995.

This report describes average NAEP math, science, and reading test scores for 1990
public high school graduates and the relationship of these achievement test scores to
vocational, academic, and personal use coursetaking.

GPO order number: 065-000-00766-5. Cost: $4.00

Rp3:Ch1 Tables 1 to 19 Vocational Coursetaking and Achievement

Report 4
Trends in Participation in Secondary Vocational Education: 1982–92, April 1996.

This report describes trends in academic, vocational, and personal use coursetaking for
public high school graduates, by disability status (1987 and 1992).

GPO order number: 065-000-00857-2. Cost: $4.50

Rp4:Ch1  Table 1 Trends in Participation in Secondary Vocational
Education: 1982–92
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APPENDIX B

Examples of Importing Table Files into Spreadsheets

The following are instructions for importing a table file created in ETL into particular
spreadsheet applications. If you used the Output Options “Create a Comma-Separated
File” or “Create a Tab-Separated File” and wrote the file to a DOS subdirectory, follow
the instructions below to import these files into a spreadsheet after exiting ETL. 

Importing Table Files into Lotus 1-2-3 version 3.1

After starting Lotus, type:
(1)  /  (forward-slash) to access menu commands
(2)  F  for the File submenu
(3)  I  for the Import submenu
(4)  N  to select import as Numbers
(5)  [F2]  to edit the filename

Enter the filename, including the correct drive and path, if they are not the same as
LOTUS. For example, if your file resides in the default ETL subdirectory and your
file is called “table_1.csv,” you would enter:

C:\VL96\table_1.csv
If you are not sure of the filename, enter C:\VL96\*.* and a list of files will
appear from which you may select the file you want to import using the 
left and right arrows.

(6)  Press Enter to load the file.

Column widths will have to be adjusted for readability. To do so enter: 
(1)  /  for the menus
(2)  W  for the Worksheet submenu
(3)  C  for Column
(4)  S  for Set-Width

and use the left and right arrow keys to adjust until all the data in the column can
be seen. This adjustment must be repeated for each column.

Importing Table Files into Excel for Windows version 4.0

After starting Excel:
(1)  Pull down the File menu; select Open.
(2)  Click on Text button (for the file type).
(3)  Check that the Column Delimiter is set appropriately to either “Tab”

(for a .txt file) or “Comma” (for a .csv file) and that the File Origin is
set to “Windows (ANSI).”

(4)  Click OK.
Enter the filename, including the correct drive and path, if they are not the same as
EXCEL. For example, if your file resides in the default ETL subdirectory and your
file is called “table_1.csv,” you would enter:

C:\VL96\table_1.csv
Select it in the window by clicking on it.

(5) Press Enter to load the file.
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Column widths will have to be adjusted for readability. To do so:
(1)  Select the column to be adjusted by clicking on its letter at the top of

the spreadsheet.  
(2)  Pull down the Format menu and select Column Width.
(3)  Click on the Best Fit button.  

You can fine tune the widths by moving the mouse to the column divider at the
right of the column letter you want to adjust (the pointer should change to a cross-
hairs icon). Use the “click-and-drag” method to adjust the column width.

Importing Table Files into Excel for Windows 95 version 7.0

After starting Excel:
(1)  Pull down the File menu; select Open.
(2)  Select All Files (under Types of Files).
(3)  Select the drive and folder in which the file appears, and then the file

itself (for example, select C:\VL96 and then table_1.csv).
(4)  Select Delimited on the import Wizard, and then click Next.
(5)  Select either Tab or Comma as appropriate, and then click Next.
(6)  Select General (under Column Data Format).
(7)  Click Finish.


